IPA 9.0: Release Notes

Product Release Information
About IPA 9.0
What's New in IPA 9.0?
   Application
   Content
Known Issues
General Helpful Information and Known Issues
System Requirements

Product Release Information
Product: IPA
Release Number: 9.0
Release Date: 2011/03/12
Customer Support: For more information or support, visit our website or e-mail us at support@ingenuity.com

About IPA 9.0

IPA® is a web-based software application that enables you to analyze data derived from expression and SNP microarrays, proteomics and metabolomics experiments, and small-scale experiments that generate gene lists. It also enables you to search for targeted information on genes, proteins, chemicals, diseases, and drugs, as well as build your own biological models. IPA’s data analysis and experimental modeling enables you to understand the significance of your data or target of interest in relation to larger biological or chemical systems, backed by the Ingenuity® Knowledge Base, a uniquely structured repository of biological and chemical Findings, and then generate custom reports to communicate and share your insights with collaborators.
What’s New in IPA 9.0?

Application

New Quick Start

When you open IPA, you will see a new Quick Start that provides buttons to launch certain features or to bring up tutorials to help you quickly get up to speed on how IPA can help your research. The new Quick Start helps you streamline valuable workflows such as:

- Upload and analyze data
- View pathways
- Search for genes
- Visualize connections among genes
- Understand specialized features

Note that the original version of Quick Start is still available by clicking the Shortcuts tab in the new Quick Start.

New microRNA Target Filter

New microRNA capabilities in IPA enable you to upload, analyze, prioritize, filter, and visualize microRNA-mRNA data and relationships, all within a single tool. The microRNA Target Filter in IPA provides insights into the biological effects of microRNAs, using both experimentally demonstrated and predicted microRNA-mRNA relationships (from TarBase and TargetScan, www.ingenuity.com
respectively). The microRNA Target Filter reduces the number of steps it takes to confidently, quickly, and easily identify mRNA targets by associating microRNAs from your dataset with experimentally observed and predicted mRNA targets and letting you examine microRNA-mRNA pairings, explore the related biological context, and filter based on relevant biological information as well as the expression information. The ability to leverage biological context is key to overcoming the inherent complexity in current microRNA data analysis.

With the new microRNA Target Filter

- Identify mRNA targets of microRNAs using predicted and experimentally observed relationships
- Prioritize microRNAs and targets using experimentally validated information about the mRNAs
- Leverage your own microRNA and mRNA expression data
- Employ widely used microRNA target identification workflows, coupled with literature-based information and pathway tools to visualize and interpret effects

To start a new microRNA Target Filter, click on the button and select New microRNA Target Filter.

New RNA-Sequencing Data Support
Directly upload processed RNA-Seq datasets into IPA to analyze and understand this data in the context of known biology to get a comprehensive view of your experimental system.

- Quickly move beyond statistical analysis of high-throughput RNA-Seq data to understand the biological implications of your data, so you can accurately identify novel disease mechanisms, prioritize drug targets, generate hypotheses, and more.
- Seamlessly move from data processing tools to biological interpretation in IPA by directly uploading RefSeq, Ensembl, and UCSC IDs.

www.ingenuity.com
New Customer Support Portal

In an effort to continually provide the best help documentation and customer support, Ingenuity has launched the new Customer Support Portal. All help documentation (except Workflow Help) in IPA has been moved to this centrally located and maintained help system. This means you will have access to the most up-to-date help articles, videos and tutorials directly from IPA into this web-based support portal. These articles and help documents are categorized, searchable, and can be found on the Help tab.

To foster the IPA user community the Customer Support Portal provides a Customer Forum to post questions to Ingenuity and the user community. See how others are using IPA for their research and share best practices on how you are using IPA. When entering the question, prior to posting, the Customer Support Portal will search the help portal for any related documentation that may answer your question. Get fast easy access to help documents and answers to your IPA questions.

Ingenuity values your feedback and suggestions for enhancing IPA, and the new Customer Support Portal includes a new Feedback capability where you can post suggestions for product enhancements, new platforms to support, or new research areas to consider for content or application capabilities. We encourage the IPA user community to vote on these suggestions to help us prioritize them for consideration in future versions of IPA.

In the instance you find a defect or have a question about how to use IPA there is access to Ingenuity Customer Support via Chat, phone, or you can enter a support case on the Support tab of the Customer Support Portal. You can come back and view updates to your case at any time of the day.

www.ingenuity.com
Simplified Workflows and Improved User Experience

1) Ability to Start an Analysis or Filter from a Dataset
After you save an uploaded dataset, it now opens and provides options to filter it or analyze it.

2) Functional Analysis in table format (in addition to tree format)
When you run an analysis in IPA (Core, Tox, Metabolomics), Functional Analysis results are displayed in a new convenient new table format. Clicking on any bar in the bar chart filters the table to display the results for that particular function.
3) **Copy network or Path Designer pathways and paste as images into other applications**

You can copy selected nodes and edges while viewing networks or Path Designer pathways and paste as an image into other applications such as PowerPoint or Word.

4) **Improved behavior when closing the application**

- Prior to IPA 9.0, clicking the red ‘X’ (at the top right of the application window) would close IPA without warning. Now, you will have the option to cancel closing IPA. If you close the application this way, your session will end but you will still be able to re-launch IPA without signing in if you had checked the “Keep me logged in” checkbox during login.
• Clicking the “Sign out” link underneath the red ‘X’ will close IPA, end your session, and force the need to sign in again at login to return to IPA. In essence, it “unchecks” the keep me logged in checkbox. The same is true if you exit IPA using the “Sign Out” link under the File menu in IPA.

5) Other improvements throughout IPA

• Improved method to remove duplicate probes when there are multiple cutoffs applied. See help for additional information.
• “Enriched Dataset” is now called “Annotated Dataset”.
• Human genes that are present in multiple copies in the human genome are now represented in a single gene view. See SMN1/SMN2 for example.
• Increased row limit for uploaded files to 100,000 rows.
• Approve or “Un-Approve” all My Pathways or My Lists simultaneously for use in analyses by right-clicking on the My Pathways or My Lists icon respectively in a particular project:

www.ingenuity.com
Content

TargetScan Predicted microRNA-mRNA Target Interactions

Over 600,000 predicted microRNA-mRNA target relationships from TargetScan were added to the Ingenuity Knowledge Base. The confidence levels of those predictions were determined with consultation from TargetScan and organized into High and Moderate levels of confidence of the prediction for easier use in the microRNA Target Filter.

- High (predicted) confidence is assigned either if the relationship is between a conserved or highly conserved microRNA as defined by TargetScan and at least one conserved site on the targeted sequence or the total context score, as defined by TargetScan, is -0.4 or less. This indicates that the microRNA is predicted to repress the expression of its mRNA target to 40% of the "normal" level.
- Moderate (predicted) confidence is assigned if the total context score, as defined by TargetScan, is -0.2 or less. This indicates that the microRNA is predicted to repress the expression of its mRNA target to 65% of the "normal" level.

New Drug/Clinical Candidate Content

- ~1200 new clinical trials from ClinicalTrials.gov
- ~100 new drugs with molecular targets
- ~50 new diseases included as a result of ClinicalTrials.gov content update

Additional Nephrotoxicity Content

Increase in Nephrotoxicity content availability to Tox Functions
- 55% increase in # of Findings that support Nephrotoxicity endpoints in Tox Functions
- 32% increase in # of molecules associated with Nephrotoxicity endpoints in Tox Functions

New Cellular and Humoral Immune Response Content

~ 18,000 new findings from 620 articles related to cellular and humoral immune responses and pathogenesis.

New Chemical Content

In addition to what is detailed above, ~150 new chemicals with ChemViews (containing information such as PubChem IDs, CAS IDs, InChI, and SMILES notations).

Third party database updates

Updates to content from molecular interaction databases (BIOGRID, INTACT, MINT)
- ~12300 new Findings from BIOGRID
- ~3400 new Findings from IntAct
- ~2300 new Findings from MINT

New Canonical Pathways

www.ingenuity.com
12 new Signaling Pathways related to cytokine signaling and inflammatory disease:

1. IL-17A Signaling in Airway Cells
2. Role of IL-17A in Arthritis
3. IL-17A Signaling in Fibroblasts
4. IL-17A Signaling in Gastric Cells
5. Role of IL-17A in Psoriasis
6. Role of IL-17F in Allergic Inflammatory Airway Diseases
7. Differential Regulation of Cytokine Production in Macrophages and T Helper Cells by IL-17A and IL-17F
8. Differential Regulation of Cytokine Production in Intestinal Epithelial Cells by IL-17A and IL-17F
9. Role of JAK1, JAK2 and TYK2 in Interferon Signaling
10. Role of JAK2 in Hormone-like Cytokine Signaling
11. Role of JAK family kinases in IL-6-type Cytokine Signaling
12. Role of JAK1 and JAK3 in γc Cytokine Signaling

Updated Canonical Pathways

10 of the most popular Signaling Pathways were updated to make sure users of these pathways have access to the most up-to-date and relevant data.

1. Apoptosis Signaling
2. Aryl Hydrocarbon Receptor Signaling
3. Axonal Guidance Signaling
4. Glucocorticoid Receptor Signaling
5. IGF-1 Signaling
6. ILK Signaling
7. Integrin Signaling
8. Mitochondrial Dysfunction
9. NF-κB Signaling
10. TGF-β Signaling

Improved Identifier Mapping and Reference

- New IDs to support the RNA-Seq workflow in IPA:
  Three new Identifier types are added in this release to support the mappings of the isoform id:
  - Ensembl
  - UCSC HG18
  - UCSC HG19

The following additional chips are now supported:

Agilent:
028679 SurePrint G3 Human Exon 4x180K Microarray
028680 SurePrint G3 Human Exon 2x400K Microarray
028727 SurePrint G3 Mouse Exon 2x400K Microarray
028728 SurePrint G3 Rat Exon 2x400K Microarray
028744 SurePrint G3 Rat Exon 4x180K Microarray
030493 SurePrint G3 Mouse Exon 4x180K Microarray

www.ingenuity.com
031181  Unrestricted Human miRNA V16.0 Microarray
031184  Unrestricted Mouse miRNA V16.0 Microarray
028081  SurePrint G3 Human CGHplusSNP Microarray 2X400K
029830  SurePrint G3 Human CGHplusSNP Microarray 4X180K

The following reference sets were added to IPA 9.0 for use in data analysis:

11220  SurePrint G3 Human Exon 4x180K Microarray
11221  SurePrint G3 Human Exon 2x400K Microarray
11222  SurePrint G3 Mouse Exon 2x400K Microarray
11223  SurePrint G3 Rat Exon 2x400K Microarray
11224  SurePrint G3 Rat Exon 4x180K Microarray
11225  SurePrint G3 Mouse Exon 4x180K Microarray
11228  SurePrint G3 Human CGHplusSNP Microarray 2X400K
11229  SurePrint G3 Human CGHplusSNP Microarray 4X180K

miRBase Updates:

- Mapping to miRBase accessions and IDs in miRBase version 16 released in the Fall of 2010.
- Mapping of stemloop miRNA accessions (users can now map to “MIxxxxxx” ID’s in addition to mature miRNA ID’s, of the form “MIMATxxxxxx”.)
- MicroRNAs history (obsolete microRNA names) was added to support better mapping.
- Individual microRNAs are grouped into microRNA families as defined by miRBase.

Identifier source versions:

Affymetrix:  na31, 8/23/2010
Agilent:     various, as of 12/13/2010
dbSNP:      b132(human)
            b131(bovine,mouse)
            b130(rat,zebrafish)
            b128(chicken, nematode)
            b126(dog)
EntrezGene: daily, 12/13/2010
Ensembl:    Human 59, Mouse 61, Rat 61
Genbank:    NCBI-GenBank Flat File Release 180.0, 10/20/2010
HGNC:      12/13/2010
Homologene: Build 64, 8/10/2009
Illumina:   As of 12/13/2010
RefSeq:     Release 44,11/10/2010
Unigene:    Human(#228), Mouse(#187), Rat(#187)
Uniprot:    UniProt release 2010_11, 11/30/2010

General Helpful Information and Known Issues

The following section lists known issues with IPA 9.0 at the time of release. To learn the latest news, tips or known issues, contact Ingenuity Customer Support at support@ingenuity.com or call ++1-650-381-5111.

www.ingenuity.com
Please note: In IPA 9.1, we will remove the Rosetta integration link in IPA. This means that at that time you will no longer be able to send gene lists to Resolver directly from IPA, but you may continue to send datasets to IPA from Rosetta.

General Known Issues:

- Starting in IPA 9.0, when you change your memory allocation for the IPA client, you are setting it for you as a user, rather than for a particular computer. It is therefore possible for you to set IPA’s memory allocation to its highest setting when using it on one machine (a powerful desktop computer for example), but in so doing prevent IPA from launching on a lesser machine that you may use (an older laptop for example). If this situation occurs, go to https://analysis.ingenuity.com/pa/launch/public/memory on the lesser machine to lower the memory requirement and launch IPA.
- When reviewing the Analysis Settings page for analyses run prior to IPA 8.6, the Data Sources filter will display the Additional interactions Findings option as unselected, even though that option was not available when the analysis was originally run.
- When accessing IPA via a link in a PDF report viewed in an HTML page, two sign in dialogs are created. This occurs due to incompatibility between Internet Explorer 8 and certain Java versions and it can be resolved by following the steps in attached link: http://forums.sun.com/thread.jspa?threadID=5434714. As suggested in the thread, turn SmartScreen Filter off (IE8-> Tools ->Internet Options -> Advanced -> Security) to resolve this issue.
- After performing a Highlight with Fill option, the ‘Save’ button becomes enabled. The Pathway can be saved, however the Highlight Fill information will not be included in the saved Pathway.
- Ingenuity® ExpertAssist Findings
  - When reviewing the Analysis Settings page for analyses run prior to IPA 8.5, the Data Sources filter will display the Ingenuity ExpertAssist Findings option as unselected, even though that option was not available when the analysis was originally run.
  - For some networks and pathways created prior to IPA 8.5, highlighting Ingenuity® Expert Findings will result in highlighted relationships for which a Finding no longer exists. Please use the Refresh tool to update your network or pathway.
  - Display of selected Data Sources in Filter settings for older analyses: in analyses created prior to the addition of a particular data source, that data source will now show up as unchecked in the analysis filter settings.
- Improved Network and Pathway Visualization
  - When viewing references in a pathway, all available supporting references for the visible relationships will be displayed, not just those references supporting the specific Findings that support the relationships generated with specific data source filter settings.
  - The Full Screen View will not work for users logged into IPA using applet mode.
- Caching for Improved Performance
  - For Mac OS, the default size of the caching directory is configured to be smaller than Windows OS.
  - The IPA cache size setting on Mac OS affects the new 100 MB file upload limit. To increase the cache limit to upload large datasets, go to IPA’s File > www.ingenuity.com
Preferences > Application Preferences > Application > Maximum Memory. Set to 'High (1000mb)'. This will result in an error message that you should ignore.

- **Dynamically Generated Pathway and List Reports:**
  - My Pathways generated from Import Pathway (SBML Beta) will cause the Report page to return an error message and prevent it from being opened.
  - If changes are made to a Pathway after the Report page has already been opened, the Report page will need to be refreshed, or closed and re-opened, to reflect the changes in Pathway data.

- **Improved Search Functionality:**
  - Exporting results from a Functions and Disease search in Excel format (.xls) produces an unreadable file. To export Function and Disease results, please use .txt formatting instead.
  - Saved Advanced Search queries do not run when executed in some cases.
  - If you type text into the auto-complete box and then use backspace to delete some characters, auto-complete will not display matches to the term as it exists in the search box.
  - Custom molecules are not displayed in auto-complete.
  - Some auto-complete terms are longer than the allowed 256-character search term limit and may result in the message: “Search term character limit exceeded”. If this message occurs, reduce the length of the term in the search field and re-run the search.
  - When performing a multi-line search for Pathways and Tox Lists, only the first term will be highlighted in the results.

- **Drag and Drop Functionality:**
  - An object in the Project Manager must be selected prior to using the Drag and Drop functionality.
  - This issue is only for users who have Java 1.5.

- **My Pathways**
  - Publication Date Range Filters: A small percentage of Ingenuity Findings do not have publication dates associated with them. When looking at a network or pathway that consists of relationships that are supported only by these Findings, the Publication Date Range Filter will not be available for Trim, Keep or Highlight operations.
  - In some instances, due to a known Java error, the applet does not shut down immediately upon exit. If the IPA applet is restarted before the previous instance has shut down, errors in opening new My Pathways may occur.
  - Biomarker Overlay and Trim/Keep/Highlight filters do not apply to changed or deleted molecules (i.e., molecules in older pathways that are marked with a delta symbol).
  - The Refresh existing connections button does not currently include reaction relationships as part of the refresh process. To refresh Pathways and Networks with reaction relationships, please use the Connect tool.

**General functionality**

- Some relationships in Canonical Pathways are drawn to depict an inhibitory interaction between molecules when the relationship is not associated with any inhibition Findings.

[www.ingenuity.com](http://www.ingenuity.com)
is because the net effect of the interaction supporting that relationship is inhibition, so the relationship is drawn to reflect that outcome.

- Mac OS 10.4.x (Tiger), is no longer supported.
- Users using Firefox 3.0.15 from IPA applet mode may experience tool slowness to the point that the application becomes unresponsive. Users who experience this condition should use IE 8 or Firefox 3.6.

- Some enriched or filtered multi-observation datasets containing duplicate IDs may present difficulty when opening.
- If a My Pathway or Network contains a molecule that was deleted, merged, or split, overlay of Biomarkers, Pathways, Drugs and Functions and Diseases will not apply to those molecules. To apply new information about this changed molecule, click on the molecule to identify the new molecule that it now maps to, and then add that molecule to your pathway.
- ID Mapping: When a source ID has been deprecated, it is considered retired. However this status is not updated if the source reinstates the ID. This prevents some IDs from being mapped.
- Pathway SBML Import \(^{Beta}\):
  - This is a Beta Feature.
  - There is a file size limit of 1MB.
  - There is a 500 node limit.
  - Biomodels Level 2, version 3 does not import correctly. You will get the error: 'Unable to parse input'.
  - Attempting to import an unsupported file type (e.g., non-xml) will result in an error.
- Pathways and Path Designer:
  - Neighborhood View: Nodes in the Neighborhood View will now only be connected to the central node, not with one another. In order to view the node inter-connections, use the Connect feature.
  - Species-Specific Labeling:
    - The species specific labeling skips the split or merged nodes in old pathways.
    - For some high resolution and large images, attempting to export the image produces an error message asking you to resize the image or reduce the resolution before exporting.
  - The autolayout for enzyme-catalyzed reactions uploaded from CellDesigner is not optimal, even for small files.
  - Image Export:
    - Images exported in EPS format, when viewed in Adobe Photoshop or in one of the EPS viewers, are not correct.
    - Mac: Image Export from Path Designer to EPS results in an error.
    - A single circle is shown as icon for Complex genes in the IPA legend, instead of a double circle.
  - Trim: When trimming Findings using a Stringent filter, if the edge also contains a Finding where only one node is of the selected species, then the two-species edge will not be trimmed.
  - Mac: On Mac OS 10.4 running Java 1.5, some cell art may cause a refresh or paint problem.
- Content:

www.ingenuity.com
• ID Mapping: Some EG IDs incorrectly map to multiple nodes and some which should be deleted are still mappable.

• Analyses:
  o Focus genes and expression values shown on Comparison Analysis Settings page are only shown for first analysis in comparison.
  o Creating an analysis from a filtered multi-observation dataset: When you apply an expression value cutoff to a multi-observation dataset and then use that dataset for analysis, IPA will identify all molecules across the dataset observations that meet the filter criteria and then utilize the union of those molecules as input to the analysis. This means that a molecule which was excluded from a specific observation in the filtered dataset may now be available for that observation on the Create Analysis page, if that molecule meets the cutoff for a different observation. When creating an analysis, if you wish to reestablish the variation across multiple observations that you produced when filtering your dataset, apply the same cutoff to the analysis as was used in the filtered dataset.

• New filters have been added in this release. If you have customized the default filter preferences for creating analyses, or restored defaults & saved them, then the new filters will not automatically be added to your list of selected filters.
• Analyses created with previous version of IPA that had been filtered on “Unspecified Cells” won’t have a corresponding Effect on Function
• The MK886 analysis will no longer appear under the list of Sample Analyses.
• We have stopped mapping the majority of the integer IDs on deprecated Illumina chips. We have completely phased out these integer IDs in IPA 7.5. You will receive a warning message in the upload widget whenever saving a dataset with integer IDs and with an Illumina ID type. This message advises you to use GI or REFSEQ IDs to map these chips.

• Probe set IDs on Affymetrix Exon chips are no longer mapped in IPA, by request from Affymetrix. Affymetrix has recommended that we no longer map probe set IDs, and instead, only use transcript IDs for mapping.

• Java-related issues:
  o Use of IPA with JRE 1.4.x is not supported.
  o Context Filter: The advanced options do not get refreshed when switching from Stringent to Relaxed Filter.

  o Path Designer fails to show shapes for genes in JRE 1.5.0_16 web start mode. You must use IPA in applet mode if utilizing Path Designer in IPA for this JRE version.

  o If you are trying to login to IPA with JRE 1.4.x and have used IPA earlier when we supported this JRE version, the IPA launch icon will remain on your desktop. If you now attempt to access IPA by clicking on this icon, IPA attempts to launch and gets stuck with message “Starting application…”
  o ’Binding‘ relationship types are no longer supported in IPA, and tool-related operations on such relationships in older analyses will not have any effect.
  o Some direct interactions in older analyses may be displayed as indirect interactions.
  o Since IPA 5, IPA may be launched using Web Start, allowing IPA to run as a Java application (versus a Java applet, which is dependent on a web browser). As a Java application, IPA will improve from a performance perspective, i.e. the application will run faster.

www.ingenuity.com
Web Start was developed by Sun Microsystems, the same company that develops Java Runtime Environment (JRE). Specific versions of JRE have known conflicts with Web Start, namely JRE 1.5.0_07, _08 and _09. Mac Platform: We recommend the following (if possible):

- For OS 10.4 and 10.5, use JRE 1.5.0_13.
- If you have JRE 1.5.0_07 on your Mac and you are not able to upgrade to JRE 1.5.0_13, an alternative method for accessing IPA exists. You may run IPA through a Safari web browser (applet version) using an alternate URL.

PC Platform: We recommend using JRE 1.5.0_10 or JRE 1.6.0.

JRE downloads are available at:
http://www.ingenuity.com/login_troubleshooting/jre.html

Note: In IPA versions after IPA 6.3, the application will require JRE version 1.5.0 or higher. IPA may still run on JRE 1.4.2, but usage of this JRE will not be supported.

Application performance:

- The initial login to IPA may take a few minutes. Subsequent login times will take less time. In addition, it may take about one minute for analyses to open. However, subsequent actions within the opened analysis (e.g. opening a network) are much more responsive.

Analyses created prior to IPA 7.5 - Below are some expected changes:

- Δ (delta) found in network diagrams:
  - Molecules marked with the Δ (delta) symbol have undergone a change from a previous content release. Changes include: Merging of two or more molecules into one.
  - Splitting one molecule into two or more molecules.
  - Deletion of an obsolete molecule name.

- Functional analyses:
  - With the updates made to the Ingenuity Knowledge Base, some of the specific functions may either map to new specific functions, or no longer map to any specific functions.

- Canonical pathway analyses:
  - In IPA 4.0, the “Prostaglandin and Leukotriene Metabolism” canonical pathway was split into two pathways, called “Arachidonic Acid Metabolism” and “Linoleic Acid Metabolism” pathways.

www.ingenuity.com
- The “Prostaglandin and Leukotriene Metabolism” canonical pathway cannot be opened if created in analyses prior to IPA 4.0.

- In IPA 5, the “Complement and Coagulation” canonical pathway was split into two pathways, “Complement System” and “Coagulation System” pathways. The Complement and Coagulation canonical pathway cannot be opened in analyses created prior to IPA 5. Run the dataset in IPA 6 to see how genes from the dataset overlap with molecules in that canonical pathway.

- Dataset files must be tab-delimited ASCII text or Excel files. When using the Ingenuity file format templates (A or B), do not use space-delimited format for your dataset files. Refer to the Help documentation within IPA for more details on available file formats.

- Molecule limit for My Pathways and Path Designer pathways:
  - The My Pathways and Path Designer features have a limit of 500 molecules.

- Copy limit:
  - Copying several items (e.g. when sharing dataset files, analysis results with others) at one time may generate application errors. To avoid this issue, limit the number of items to be copied at one time to five (5).

- Refresh of the Project Manager:
  - The Project Manager refreshes automatically once every 5 minutes. You also have the option of manually refreshing by pressing the Refresh button.

- Tooltips in Japanese Internet Explorer 6.0:
  - For Japanese Internet Explorer 6.0, the tooltips either appear blank or contains stray characters.

- Opened pop-up windows (wizards, overlay tools, etc.) temporarily disable other browser windows. In some situations when using the Firefox browser, when a pop-up window is open, other Firefox windows become disabled. To resolve this issue, close the pop-up window.

- Application may become hidden in tabbed browser. When IPA is running in a browser that supports tabs, e.g. Firefox, the application may become hidden if another web page is called into the same browser window. To navigate back to IPA, depress Ctrl + Tab on the keyboard.

- Analyses run with custom molecules:
  - When creating an analysis with a List that contains custom molecules, the custom molecules will appear as dashes “—” in the Dataset File Mapping section of the Settings page.

- Gene symbols appended with Δ (delta) symbols:

  www.ingenuity.com
On the Networks page, the filter function does not work with gene symbols appended with the delta symbol.

- **JRE 1.6.0-related issues:** A checkbox for an item may need to be selected multiple times for it to become selected.

- **Issues related to layout of molecules on My Pathways:**
  - When executing the Grow tool and adding a large number of molecules, the molecules may appear stacked on top of one another in the diagram. Click the Auto-Layout button or manually move the molecules to separate them.
  - The long molecule names may become obscured with the Auto-Layout tool. Manually move the molecules to separate them.

- **Issues related to Canonical Pathways:**
  - The number of journal articles that support a relationship between molecules on a canonical pathway is not visible. Click the relationship to view the Findings and associated references that support the interaction between the molecules.
  - Deleting relationships between molecules on a canonical pathway:
    - Some molecules may have multiple relationships that exist between them. In such cases, multiple lines may connect them, which require multiple deletion events. To quickly delete all the edges, select the two molecules and use the Trim tool to remove all relationships.
  - Viewing members of or Grow from molecules that appear multiple times on a canonical pathway:
    - In situations where multiple instances of the molecule exist on a diagram, viewing members for, or Growing from, only one of the duplicates is allowed. To view/Grow from the other molecule, remove changes that were made to the first.
  - Large self relationships on canonical pathways:
    - In some situations, using the Grow tool will create large arrows (self relationships).
  - Deleting graphics on canonical pathways:
    - Graphics such as DNA molecules and cell membrane boundaries cannot be deleted from canonical pathway diagrams. Add all of the molecules to a List and then add them to a My Pathway or edit the pathway in Path Designer.
  - Connect and reaction relationships:
When using the Connect tool in a canonical pathway to add reaction relationships, in certain situations all of the relationships may not be initially visible – some may be hidden under existing ones.

- **Species & Tissue Overlay and undoing an action:**
  - After selecting a species or tissue to highlight on a network or pathway, the Undo button is disabled, i.e. the highlight action cannot be undone. To remove the highlight, click the Reset button.

- **Custom Gene Views from an interactive pathway e-mail not viewable:**
  - A custom Gene View cannot be opened from an e-mail containing an interactive pathway. All non-custom molecules and relationships are viewable.

- **Only endogenous mammalian chemicals are eligible for network generation. Relationships that include non-endogenous chemicals are not eligible for network generation. To add non-endogenous chemicals to a network or pathway, use the Grow tool.**

- **Inconsistent term highlighting in Search:**
  - Highlighting of query terms in the matched term column of the Search results is not consistent.

- **Lists from List Analysis not viewable in Shared project:**
  - My Lists that are analyzed (e.g. Core or IPA-Tox) are not viewable by those invited to a shared project. Share the Lists themselves into the same Shared project to view the contents from the List in the analysis.

- **Application timeout:**
  - Once the application has timed, it disappears from the desktop.
  - The standard time out is set to 2 hr. In some accounts, the time out may be customized and as a result longer or shorter.

- **Issues related to Path Designer**
  - Memory issues when running IPA in applet mode:
    - Since Path Designer is graphics intensive, it uses a significant amount of memory. When running IPA in applet mode (IPA running in a web browser), and having multiple Path Designer pathways open and trying to simultaneously open multiple analyses, the computer may run out of available memory.
    - To allocate more memory to IPA, follow these steps:
      1. Go to the Start menu -> Settings -> Control Panel -> click on the Java icon.

www.ingenuity.com
2. Click on the "Advanced" tab.

3. In the box labeled "Java Runtime Parameters", in the line listing the latest version of Java, paste or type the following string: -Xms28m -Xmx400m.

4. Re-log in to your IPA account.

   - Memory issues when running IPA using JRE 1.4.2 in Web Start mode:
     - Since Path Designer is graphics intensive, it uses a significant amount of memory. When running IPA using JRE 1.4.2 in Web Start mode, and having multiple Path Designer pathways open and trying to simultaneously open multiple analyses, the computer may run out of available memory.
     - Memory allocation cannot be modified in Web Start mode. We recommend that the JRE is upgraded to JRE 1.5.0 or higher.

   - Pixelated images printed:
     - Cell Art objects (e.g. mitochondria) are pixilated when a Path Designer pathway is printed.
     - Export the Path Designer pathway to a file (e.g. JPG Format) and print it.
     - Background color in gradient mode. The background color with gradient will not appear correctly when exported in GIF format. Export the pathway in a different file format (e.g. JPG Format).

   - Auto-Layout in Path Designer:
     - If a My Pathway or Network is in Sub-cellular Location mode is transformed into a Path Designer pathway, the molecules are scattered if the Auto-Layout button is clicked.

   - Sub-cellular Location impact on Legend in Path Designer:
     - When a My Pathway or Network is transformed using Path Designer, if the pathway or network is in Sub-cellular Location mode, the Path Designer legend will contain a line item called Graphic Node. Delete the demarcation lines and click the Legend button to remove the Graphic Node line item.

   - Path Designer bold text on Macs:
     - Bolding of some fonts, e.g. Monaco, is not possible in Path Designer.

   - Restoring default of edited lines in Path Designer
     - If a line is edited, e.g. increase weight, the line type changes to a dashed line after clicking Restore Default.

- Tox Functions with p-values > 0.05 returned:
  www.ingenuity.com
• In some situations, Tox Functions with p-values greater than 0.05 are returned in Functional analyses.

• Clicking links within HTML pages:
  • When clicking links on HTML pages, e.g. Gene View, to launch a Java-based feature, e.g. a canonical pathway, a Windows dialog box appears giving the appearance that IPA is launching itself. Click the Open button in the dialog box and the requested feature will appear in IPA.

• Bolded and hyperlinked text on Macs:
  • In some areas of the application, e.g. Relationship Summary, text is obscured due to text bolding or hyperlinked text.

• Vertical scroll bars absent on Vista operating system:
  • In a Path Designer pathway, when using one of the Build tools, the vertical scroll bar does not appear for some of the parameters. Use the arrow buttons on the scroll bar to navigate.

System Requirements

IMPORTANT:
1. Pop-up blockers must be disabled for the application to function in applet mode inside a web browser.
2. Please note that IPA has phased out support for JRE 1.4.2. We recommend anyone who uses this version to upgrade to a later version. Refer to the Helpful Information and Known Issues section for clarification.
3. Tiger, or Mac OS 10.4.x, is no long supported.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating System*</th>
<th>Web Browser**</th>
<th>JRE***</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qualified</td>
<td>PC Windows 7</td>
<td>IE8, FF3.6</td>
<td>1.6.0_21</td>
</tr>
<tr>
<td></td>
<td>PC Windows XP SP2</td>
<td>IE6, IE7, IE8, FF2, FF3</td>
<td>1.5.0_06, 1.6.0_18</td>
</tr>
<tr>
<td></td>
<td>PC Vista</td>
<td>IE7, IE8</td>
<td>1.5.0_06, 1.6.0_18</td>
</tr>
<tr>
<td></td>
<td>Mac 10.6.6 (Snow Leopard)</td>
<td>Safari 5.0.3</td>
<td>1.6.0_22</td>
</tr>
<tr>
<td></td>
<td>Mac 10.5.8 (Leopard)</td>
<td>Safari 5.0.3</td>
<td>1.5.0_26</td>
</tr>
<tr>
<td>Supported</td>
<td>PC Windows 7</td>
<td>FF3.5</td>
<td>1.5.0_x, 1.6.0_x</td>
</tr>
<tr>
<td></td>
<td>PC Vista</td>
<td>FF2, FF3</td>
<td>1.5.0_x, 1.6.0_x</td>
</tr>
</tbody>
</table>

www.ingenuity.com
* If you are unsure of your operating system version, go to Control Panel, System to check which one is installed on your computer. If you do not have one of the above operating systems, contact Ingenuity Customer Support at support@ingenuity.com or 1-(650)-381-5111 for more help.

** If you are unsure of your web browser version, go to the Help menu at the top of the web browser and choose About Internet Explorer. Update the browser if necessary. You can update your browser at http://www.microsoft.com/windows/ie/downloads/default.asp. In addition, Firefox version 1.0 or higher is also supported on PCs, but not on Macs.

*** Java Runtime Environment (JRE) is the program required to run Java applications and applets on your computer. We recommend the use of JRE version 1.6.0_18. To download, please go to http://www.ingenuity.com/login_troubleshooting.html. Additionally JRE versions 1.5.0_07, 1.5.0_08, and 1.5.0_09 are incompatible with Java Web Start. If you are unsure of your JRE version, open your control panel, click on the Java icon, and go to the section "About".

### Hardware Requirements

<table>
<thead>
<tr>
<th>Platform</th>
<th>Processor</th>
<th>OS Type</th>
<th>OS</th>
<th>Memory</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qualified</td>
<td>PC</td>
<td>1.25 GHz</td>
<td>32-Bit</td>
<td>Windows 7</td>
<td>1GB RAM (Recommended 2GB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Minimum Screen resolution</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Height: 1024</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Width: 768 pixels</td>
</tr>
<tr>
<td></td>
<td>PC</td>
<td>1.25 GHz</td>
<td>32-Bit</td>
<td>Windows XP</td>
<td>512 MB RAM (Recommended 1GB)</td>
</tr>
<tr>
<td></td>
<td>PC</td>
<td>1.25 GHz</td>
<td>32-Bit</td>
<td>Windows Vista</td>
<td>1GB RAM (Recommended 2GB)</td>
</tr>
<tr>
<td></td>
<td>Mac</td>
<td>1.25 GHz</td>
<td>32-Bit</td>
<td>Leopard</td>
<td>1GB RAM (Recommended 2GB)</td>
</tr>
<tr>
<td></td>
<td>Mac</td>
<td>2 GHz</td>
<td>64-Bit</td>
<td>Snow</td>
<td>1GB RAM (Recommended 2GB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Minimum Screen resolution</td>
</tr>
</tbody>
</table>

www.ingenuity.com
<table>
<thead>
<tr>
<th>Supported</th>
<th>PC</th>
<th>1.25 GHz</th>
<th>64-Bit</th>
<th>Windows 7</th>
<th>1GB RAM (Recommended 2GB)</th>
<th>Height: 1024</th>
<th>Width: 768 pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac</td>
<td>1.25 GHz</td>
<td>32-Bit</td>
<td>Snow Leopard</td>
<td>512 MB RAM (Recommended 1GB)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>